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Introduction 
Adobe Dreamweaver CS5.5 is a widely used industry standard program for website creation. For 
both beginners and experienced users, Dreamweaver offers the ease and flexibility to create a 
variety of websites. Another benefit of the program is the added ability to integrate files from 
other Adobe Creative Suite software such as Photoshop, Illustrator, and Flash into the final page 
design. 
 
In this handout, users will learn about the Dreamweaver CS5.5 interface and how to use its tools 
and functions. The CSULA web templates, including the steps for organizing and creating a web 
page according to the Section 508 requirements, will also be introduced. 

Downloading the Data Files 
This handout includes sample data files that can be used for hands-on practice. The data files are 
stored in a self-extracting archive. The archive must be downloaded and executed in order to 
extract the data files. 

• The data files used with this handout are available for download at 
http://www.calstatela.edu/its/training/datafiles/webtemplatescs5.5.exe. 

• Instructions on how to download and extract the data files are available at 
http://www.calstatela.edu/its/docs/download.php. 

Getting Started With Dreamweaver 
Dreamweaver is a WYSIWYG (What You See Is What You Get) web development tool that 
allows designers to develop, modify, and maintain web pages and see their changes instantly 
without requiring extensive knowledge of HTML code. 

Launching Dreamweaver CS5.5 
The following steps are for launching Dreamweaver CS5.5 using the computers in the ITS 
Training Program computer labs. The steps for launching the program on other computers may 
vary. 
 
To launch Dreamweaver CS5.5: 

1. Click the Start button, click All Programs, click Adobe Design Premium CS5.5, and 
select Adobe Dreamweaver CS5.5. 

Creating a Site Definition 
Dreamweaver provides developers with a site definition, an easy way to manage an entire 
website. With a site definition, users can effectively manage files, automatically track and update 
hyperlinks, and synchronize files with a web server. Dreamweaver CS5.5 no longer uses the Site 
Definition Wizard of CS4, opting for a more streamlined Site Setup dialog box instead. 
 
To create a site definition: 

1. Click the Site menu and select New Site. The Site Setup dialog box opens. 
2. Type CalStateFuturistsClub in the Site Name box (see Figure 1). 

NOTE: The name of the site can be anything; it is just a reference and will only appear in the 
Files panel and Manage Sites dialog box. It is recommended, but not mandatory, to give the site 

http://www.calstatela.edu/its/training/datafiles/webtemplatescs5.5.exe
http://www.calstatela.edu/its/docs/download.php
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and the local root folder the same name to reduce confusion. Remember that spaces are not 
allowed in web addresses (URLs). Avoid using spaces in file names or folder names. Instead, use 
underscores or hyphens, or capitalize the first letter in each new word to increase readability. 

3. Click the folder icon  next to the Local Site Folder box. 
4. In the Choose Root Folder dialog box, click the Desktop button in the left pane, click 

the Create New Folder button  to create a folder on the desktop, rename the new 
folder to CalStateFuturistsClub, click the Open button, and then click the Select 
button. This folder is now the local root folder. 

5. Next, click Advanced Settings in the left pane. 
6. Click the folder icon  next to the Default Images folder box (see Figure 2). 
7. In the Choose Image Folder dialog box, click the Create New Folder button, rename 

the new folder to images, click the Open button, and then click the Select button. 
8. Next to Links relative to, make sure that the Document option is selected. 
9. Click the Save button. The Files panel displays the new local root folder for your current 

site (see Figure 3). 

 
Figure 1 – Site Setup Dialog Box 

 
Figure 2 – Site Setup Dialog Box: Advanced Settings 



Creating an Accessible Website Using Dreamweaver CS5.5 and the CSULA Web Templates 5 

 
Figure 3 – Files Panel After Creating a Site Definition 

Dreamweaver Interface 
When Dreamweaver CS5.5 launches for the first time, the Welcome Screen appears in the center 
of the workspace (see Figure 4). This screen provides quick access to the most recently opened 
files and shortcuts for creating new documents of the most commonly used file types. 
Additionally, this screen offers access to useful support documentation and video tutorials. 

 
Figure 4 – Dreamweaver CS5.5 Welcome Screen 

The main Dreamweaver window is called the workspace. It contains all of the toolbars and panel 
groups used to manipulate the website’s content. Here, users can customize the placement of the 
panels and toolbars. See Figure 5 and Table 1 for a brief description of the various workspace 
elements. 
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Figure 5 – Dreamweaver CS5.5 Interface (Classic Workspace) 

Table 1 – Elements of the Dreamweaver CS5.5 Interface 

Element Description 
Application bar Contains menus and a number of additional icons for easily accessing 

commonly used features. 
Insert toolbar Contains buttons for inserting various types of objects, such as images, 

tables, and media elements, into a document. 
Document toolbar Contains buttons that provide options for different views of the 

Document window (such as Design view and Code view), various 
viewing options, and some common operations (such as previewing in a 
browser). 

Browser Navigation 
toolbar 

Becomes active in Live view and shows the address of the page that is 
open in the Document window. 

Document window The main editing area that displays the current document. Each document 
opens in a separate tab. The Status bar at the bottom of the Document 
window displays the total file size and a tag hierarchy. 

Panel groups Sets of related panels grouped together into tabs. This includes the Files 
panel which lets users manage their files and folders. These panels can be 
moved, resized, docked, and closed to suit the user’s workflow. 

Properties panel Allows users to view and change a variety of properties for the selected 
object or text. Each object has different properties. 

Workspaces 
Dreamweaver CS5.5 provides a variety of predefined workspaces geared towards different types 
of users. Each workspace arranges and displays panels to best suit individual user’s needs. The 
default workspace layout is called Designer. The workspace layout familiar to users of 
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Dreamweaver 8 is called Classic. In Dreamweaver CS5.5, users can create and save their own 
workspace to maximize their productivity. 
 
To change the current workspace: 

1. Click the Workspace Switcher menu on the Application bar and select Classic (see 
Figure 6). This workspace will be used in this handout. 

 
Figure 6 – Workspace Switcher Menu 

To save a custom workspace: 
1. First, arrange the panels and toolbars for maximum productivity. Panels and toolbars can 

be added and removed from the Window and View menus, respectively. 
2. Click the Workspace Switcher menu and select New Workspace. The New Workspace 

dialog box opens. 
3. Enter a name for the workspace in the Name box, and then click the OK button. The new 

workspace name appears at the top of the Workspace Switcher menu. 
 
To rename or delete a custom workspace: 

1. Click the Workspace Switcher menu and select Manage Workspaces. The Manage 
Workspaces dialog box opens. 

2. To rename a workspace, select the workspace, click the Rename button, enter a new 
name in the Rename Workspace dialog box, and then click the OK button. 

3. To delete a workspace, select the workspace, click the Delete button, and then click the 
Yes button to confirm. 

4. Click the OK button to close the Manage Workspaces dialog box. 

Panels 
Panels provide in-depth information about the various elements of a web page. In the Classic 
workspace, panels (with the exception of the Properties panel) appear on the right side of the 
Dreamweaver window. When panels are grouped into a single frame, they appear as tabs, much 
like web pages in a tabbed browser such as Mozilla Firefox. The two most useful panels are the 
Properties panel and the CSS Styles panel. 
 
NOTE: Pressing the F4 key hides all panels. Pressing the F4 key again will unhide all panels. 
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Properties Panel 
The Properties panel (also known as the Property inspector) appears at the bottom of the 
workspace. It provides context-sensitive information for any element selected in the Document 
window; this allows users to easily modify the properties of elements such as text, tables, and 
images. The options available in this panel vary depending on the selected item. The Properties 
panel has two different editing options: HTML for editing the selected content’s HTML code (see 
Figure 7), or CSS for editing the CSS code associated with the selected content (see Figure 8). 

 
Figure 7 – Properties Panel for HTML Editing 

 
Figure 8 – Properties Panel for CSS Editing 

CSS Styles Panel 
CSS (short for Cascading Style Sheets) is a style sheet language separate from HTML that is 
used to define the overall look of a web page. The CSS Styles panel is located in the upper-right 
corner of the Dreamweaver window (Classic workspace). This panel contains all the functions 
necessary to view, inspect, edit, and create CSS rules. The CSS Styles panel has two views: All 
and Current. 
 
NOTE: The CSS Styles panel may be collapsed. To display the panel, double-click the CSS Styles tab. 
 
All view (see Figure 9): The top pane (All Rules) displays all the classes, IDs, and tag styles that 
are available to the current web page via an external style sheet or internal CSS style definition. 
The bottom pane (Properties) displays all the properties associated with the style selected in the 
All Rules pane. Once a style is selected, the associated properties can be viewed, changed, added 
or removed (see Table 2). 
 

 
Figure 9 – CSS Styles Panel in All View 

 
Figure 10 – CSS Styles Panel in Current View 
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Current view (see Figure 10): The top pane (Summary for Selection) displays all the styles that 
are applied to the content that is currently selected in the Document window. If the mouse 
pointer is in a paragraph, the styles for that paragraph are displayed. The middle pane (Rules) 
displays all the CSS rules applied to the current element from most general to most specific. The 
bottom pane (Properties) works the same way as in All view. 
 
Table 2 – CSS Styles Panel Buttons 

Name Description 
  Category View Switches the Properties pane of the CSS Styles panel to show all 

available properties grouped by category. This view is not 
recommended due to its overwhelming nature. 

  List View Switches the Properties pane of the CSS Styles panel to show all 
available properties in alphabetical order. This view is not 
recommended due to its overwhelming nature. 

  Set Properties View Switches the Properties pane of the CSS Styles panel to show only 
the properties that are defined. Click Add Property to add a new 
CSS style at the end of the set properties list. This view is 
recommended. It shows only what CSS properties are set and 
nothing more. 

  Attach Style Sheet Attaches an external style sheet (.css file) to the web page. 

  New CSS Rule Creates a new CSS rule to be added to the web page or attached 
external style sheet. New rules can be page specific or added to an 
external style sheet. Users cannot add a style to the existing style 
sheets applied to CSULA web templates. 

  Edit Rule Changes the selected CSS rule. CSULA style sheet rules cannot be 
changed. 

  Disable/Enable CSS 
Property 

Disables or re-enables a property that is selected in the Properties 
pane of the CSS Styles panel. 

  Delete CSS Rule Removes the selected rule or property from the CSS Styles panel. 
CSULA style sheet rules cannot be deleted. 

 
NOTE: Because page authors cannot directly edit the CSS style sheets attached to the CSULA web 
templates, this handout will not go into detail about editing CSS styles. 

Toolbars 
Dreamweaver offers web developers several useful toolbars. The two most useful toolbars are 
the Document and Insert toolbars; other available toolbars include the Standard, Style Rendering, 
and Coding toolbars. Toolbars can be displayed or hidden from the Toolbars submenu of the 
View menu. The Insert toolbar can be displayed or hidden from the Window menu because 
Dreamweaver defines the Insert toolbar as a panel. Because each pane in the Insert toolbar 
contains a series of buttons, it functions more like a toolbar than a panel. 

Insert Toolbar 
In the Classic workspace, the Insert toolbar appears below the Application bar. Several tabs, 
each containing a different set of buttons, appear along the top of the toolbar. One of the most 
useful tabs is the Common tab which contains tools for adding hyperlinks, anchors, divisions, 
tables, images, and plug-ins (see Table 3). Other useful tabs include the Forms and Text tabs 
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which allow users to edit and create forms or change text properties and add list elements. The 
last tab of the Insert toolbar is the Favorites tab where users can create their own custom toolbar 
consisting of any of the buttons found on the Insert toolbar. 
 
Table 3 – Common Toolbar Buttons 

Name Description 

  Hyperlink Inserts a hyperlink. 

  Email Link Inserts an e-mail link. 

  Named Anchor Inserts a named anchor. Hyperlinks can link to named anchors. 

  Horizontal Rule Inserts a horizontal line. 

  Table Inserts a table. 

  Insert Div Tag Inserts a div tag. 

  Images Clicking the down arrow displays a menu of options such as inserting 
an image or an image placeholder. 

  Media Clicking the down arrow displays a menu of options for inserting media 
files such as SWF (Flash), ActiveX, and applets. 

Document Toolbar 
The Document toolbar, located below the Insert toolbar, contains buttons that can be used to 
display a document in different views. It also allows users to easily change the document title 
and to preview the page in a browser (see Table 4). 
 
Table 4 – Document Toolbar Buttons 

Name Description 

  Code view Displays only the Code view in the Document window. Code 
view is a hand-coding environment for writing and editing 
HTML, JavaScript, CSS, PHP, and other kinds of code. 

  Split view Splits the Document window between the Code and the 
Design views. 

  Design view Displays only the Design view in the Document window. 
Design view is a design environment that displays a fully 
editable, visual representation of the document, similar to 
what users would see when viewing the page in a browser. 

  Live view Displays a non-editable, interactive, browser-based view of 
the document in the Document window. 

  
Title 

Allows users to enter a title for the document, to be displayed 
in a browser’s Title bar. 

  Preview/Debug in Browser Allows users to preview or debug the document in a browser. 
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To switch to Design view: 
1. Click the Design button on the Document toolbar. 

 
To switch Split view to split vertically: 

1. Click the Split button on the Document toolbar. 
2. Click the View menu and select Split Vertically. 

Saving Files 
When working on a website, it is good practice to save files frequently to prevent unexpected 
loss of content. To check if a file has unsaved changes, look for an asterisk next to the file name 
on the file tab above the Document toolbar. Whenever a user makes changes to a file, an asterisk 
appears next to the file name (see Figure 11). After the file is saved, the asterisk disappears (see 
Figure 12). 
 

 
Figure 11 – File Name Before Saving 

 
Figure 12 – File Name After Saving 

To save a file: 
1. Click the File menu and select Save. 

NOTE: The Save All option allows users to save all open files that have been changed. The 
Ctrl+S keyboard shortcut saves the file currently open in the Document window. 

Exporting a Site Definition 
Dreamweaver allows users to export the site definition for portability. Exporting a website is the 
process of making a site definition (.ste) file. This file is a summary of the website; it does not 
contain any website files, images, etc. To continue working with a website from another 
computer, make copies of both the .ste and the website files.  
 
To export a site definition: 

1. Click the Site menu and select Manage Sites. The Manage Sites dialog box opens (see 
Figure 13). 

2. Select the CalStateFuturistsClub site, and then click the Export button. The Export 
Site dialog box opens. 

 
Figure 13 – Manage Sites Dialog Box 
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3. Navigate to the local root folder on the Desktop, and then click the Save button. The site 
information is saved in the CalStateFuturistsClub.ste file in the local root folder. 

4. Click the Done button to close the Manage Sites dialog box. 

Importing a Site Definition 
Importing a site definition allows Dreamweaver to manage a user’s website. This is useful for 
page authors using multiple computers to work on a website. Users can export the site definition 
(save it on a flash drive along with the entire local root folder), then import the site on another 
computer and continue working. Remember that the site definition does not contain any web 
page files; it only contains the settings Dreamweaver uses to define the website. 
 
NOTE: If the site to be imported carries the same name as a site already defined in Dreamweaver, the 
program will require that the site being imported be renamed. 
 
To import a site into Dreamweaver: 

1. Click the Site menu and select Manage Sites. The Manage Sites dialog box opens. 
2. Click the Import button. The Import Site dialog box opens. 
3. Navigate to the root folder, select the CalStateFuturistsClub.ste file, and then click the 

Open button. 
4. If prompted for the local root folder, navigate to the CalStateFuturistsClub folder and 

click the Select button. 
5. If prompted for the images folder, navigate to the images folder inside the root folder and 

click the Select button. 
6. Click the Done button to import the files into the Files panel and close the Manage Sites 

dialog box. 
 
NOTE: Do not open a website by double-clicking the .ste file. The website will not open correctly. Site 
definition files must be imported into Dreamweaver. 

Working with the CSULA Web Templates 
To create a consistent look and feel across all University web pages, Cal State L.A. provides web 
authors with a set of web page templates. These templates are available in several styles allowing 
page authors to decide which one best suits their needs. This section of the handout will detail 
these templates, their uses, and creating web pages. More information on the templates can be 
found at http://www.calstatela.edu/univ/templates/. 
 
NOTE: Since this handout was created, a new template style has been released. The templates used in this 
handout can be found at the bottom of the templates page. Both the previous and current web templates 
are acceptable for campus use. 
 
The CSULA web templates were created using PHP, a web scripting language allowing users to 
create web pages specific to their wants and needs. The templates use PHP to build the 
navigation menus and footer. Users do not need to be PHP experts to build a CSULA website. A 
PHP file is simply an HTML file with a few lines of PHP code. HTML (HyperText Markup 
Language) is the structure and design of the web page. Although advanced HTML knowledge is 
not needed to use Dreamweaver, it is recommended that users become familiar with the 
language. See the Getting Help section of this handout for more information about learning the 
basics of HTML. 

http://www.calstatela.edu/univ/templates/
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Importing the CSULA Web Templates 
The web templates can be found in the data files package as a single archive named 
WebTemplates.zip. Once you have located the zip file, the templates must be placed in the 
Dreamweaver site. 
 
NOTE: The Web Templates site (http://www.calstatela.edu/univ/templates/) contains links to 
downloadable programs for opening zipped or archived files. WinZip is available for Windows users; 
Stuff It for Mac users. 
 
To import the template files into a Dreamweaver site: 

1. In Dreamweaver, in the Files panel, right-click the first folder named Site – 
CalStateFuturistClub and select New Folder. Rename this folder to templates. 

2. Navigate to the data files folder and double-click to open the WebTemplates.zip file.  
3. Position the WinZip window over the Dreamweaver window leaving the Files panel 

visible. 
4. In the WinZip window, drag to select the template files (see Figure 14). 

 
Figure 14 – Selected Template Files 

5. Drag the selected files from the WinZip window to the templates folder in the Files 
panel of the Dreamweaver window (see Figure 15). Make sure the mouse pointer is on 
the templates folder before releasing the mouse button.  
NOTE: Users who accidentally move the files into the wrong folder can move them to the correct 
folder using the Files panel. 

http://www.calstatela.edu/univ/templates/


Creating an Accessible Website Using Dreamweaver CS5.5 and the CSULA Web Templates 14 

 
Figure 15 – Drag Highlighted Files to the Templates Folder 

Template Types 
The CSULA web templates come in three varieties: one column, two columns, and three 
columns. Each of these templates has an alternate version that contains a horizontal menu bar. 
All web templates contain a uniform banner and footer. 

One Column 
The single column template (template_1c.php) consists of a banner, title, main content section, 
and footer (see Figure 16). This simple template makes a good standalone or pop-up page. 
However, its use is limited by the lack of a menu bar. 
 
The single column alternate template (template_1c_a.php) is the same as the single column 
template, except it contains a horizontal menu bar across the top of the page between the banner 
and the title (see Figure 17). 
 

 
Figure 16 – template_1c.php 

 
Figure 17 – template_1c_a.php 
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Two Columns 
The two column template (template_2c.php) consists of the same banner, title, and footer as the 
other templates, but adds a vertical menu bar to the left of the main content section (see Figure 
18). The two column template is the most widely used template. 
 
The two column alternate template (template_2c_a.php) is the same as the standard two column 
template, but it also has the same horizontal menu bar found in the one column alternate template 
(see Figure 19). This template is a good choice for users who need two navigation menus (e.g., 
one for the department and one for the college). 
 

 
Figure 18 – template_2c.php 

 
Figure 19 – template_2c_a.php 

Three Columns 
The three column template (template_3c.php) displays the same characteristics as the two 
column template, but it includes a slightly smaller third column (see Figure 20). This column 
dynamically changes its height as content is added or removed, forcing the middle column to 
adjust accordingly. The three column template is a great way to highlight general information 
such as hours of operation while separating it from the main content column. 
 
Like the other two templates, the three column alternate template (template_3c_a.php) has the 
same horizontal menu bar (see Figure 21). Page authors who choose the alternate design and use 
the horizontal navigation menu should use the alternate across all their web pages to create a 
uniform look. 
 

 
Figure 20 – template_3c.php 

 
Figure 21 – template_3c_a.php 
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Customizing the CSULA Web Templates 
Once a suitable template is selected, it must be customized before adding the main content. The 
most important things to customize are the banner, menus, and footer. Creating a personalized 
master template simplifies future web page creation. 
 
To create a new master template from a template file: 

1. In Dreamweaver, in the Files panel, double-click the template_3c_a.php file. The file 
opens in the Document window. 

2. Click the File menu and select Save As. The Save As dialog box opens. 
3. Click the Site Root button to navigate to the root folder. 
4. Enter an appropriate file name (e.g., Master_template_3c_a.php) in the File name box, 

and then click the Save button. A dialog box opens asking to update the links. 
5. Click the No button. 

 
NOTE: A web address (URL) cannot contain spaces. Keep web page file names short using dashes or 
underscores instead of spaces when needed. 

Editing the Banner Picture 
Because the web templates are intended to create a uniform look across all student, faculty, and 
staff created pages, the majority of the banner must be left unchanged. The only customizable 
portion of the banner is the image in the upper-right corner (see Figure 22). This image can be 
replaced with another image that is 82 pixels high and no more than 130 pixels wide. 

 
Figure 22 – Template Banner Editable Region 

To change the banner image: 
1. First, obtain or create the replacement image to be used in the banner. Ensure that it is 82 

pixels high and no more than 130 pixels wide. Place this image in the site’s images 
folder. 

2. Open the template file with the banner image you want to change. 
3. Double-click the banner image. The Select Image Source dialog box opens. 
4. Navigate to the images folder, select the replacement banner image, and then click the 

OK button. 
 
NOTE: The picture’s alt text description must be changed as well. This topic will be discussed later in the 
handout. 

Making Menus 
As discussed in the Template Types section of this handout, the CSULA web templates have two 
different menus available, horizontal and vertical. Editing one of the include files (e.g., 
verticalMenu.inc) revises all the menus on the entire website.  
 
To ensure that the files are easy to find, create a separate folder to put the menu files in before 
getting started. 
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NOTE: The menu folder is not mandatory. However, it will make it easier for users to find files they are 
looking for as the website grows in size. 
 
To make a menu subfolder: 

1. In the Files panel, right-click the root folder named Site-CalStateFuturistsClub and 
select New Folder, and then rename the new folder to menus. 

2. Click the plus icon  to the left of the templates folder to expand it. 
3. Hold down the Ctrl key and click to select the footer.inc, horizontalMenu.inc, and 

verticalMenu.inc files located in the templates folder. 
4. Right-click one of the selected files, point to Edit, and select Copy. 
5. Right-click the newly created menus folder, point to Edit, and select Paste. 

 
Because the menu files have been moved, users need to fix the links to these files in their web 
pages. To do so, the PHP code must be edited. 
 
To edit the PHP code: 

1. Click the Split button on the Document toolbar. 
2. In the Document window, in the upper-left corner of the Design view, click inside the 

rectangle around the Cal State L.A. logo (see Figure 23). 

 
Figure 23 – Template in Split View 

3. In the Code view, scroll down and locate the include code for the vertical menu. 
<?php include("verticalMenu.inc"); ?> 

4. Add the text menus/ before the verticalMenu.inc file name (see Figure 24). 
<?php include("menus/verticalMenu.inc"); ?> 



Creating an Accessible Website Using Dreamweaver CS5.5 and the CSULA Web Templates 18 

 
Figure 24 – PHP Code Before and After Editing the File Path 

5. In the Code view, locate the include code for the horizontal menu and add the text 
menus/ before the horizontalMenu.inc file name. 

6. In the Design view, scroll down to the bottom of the page and click inside the beige bar 
above the school’s address. 

7. In the Code view, locate the include code for the footer and add the text menus/ before 
the footer.inc file name. 

8. After the three menu paths are fixed, switch to Design view. 
9. Click the File menu and select Save to save the changes. 

 
NOTE: The horizontal menu include only appears on the alternate templates (files ending in _a.php). The 
footer include statement appears near the bottom of the page. 

Vertical Menu 
The two and three column templates are the only ones with the vertical navigation menu which is 
defined in the verticalMenu.inc file. The vertical menu includes two options: a static menu with a 
single list of options or an animated menu with fly-out submenus. Creating the fly-out style 
menus involves editing some of the code by using a simple copy and paste operation. This lesson 
covers how to revise the static vertical menu. 
 
To edit the static vertical menu: 

1. In the Files panel, double-click the verticalMenu.inc file located in the menus folder. 
The file opens in the Document window. 

2. To edit the link text, replace the words between <a href="#"> and </a> with the desired 
link text (see Figure 25). 

3. To change the link’s destination, replace the # symbol with the desired web address 
(URL) (see Figure 25). Do not delete the quotes. 

4. Click the File menu and select Save to save the changes. 

 
Figure 25 – Vertical Menu Include File 

Creating a Fly-out Vertical Menu 
Animated menus have become more and more common with the advancement of CSS and 
scripting languages like JavaScript. The CSULA web templates make fly-out menu creation very 
simple. Page authors can include a fly-out menu in their two or three column template pages by 
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copying and pasting two different sections of code, one into their template and the other in the 
verticalMenu.inc file.  
 
To create a fly-out vertical menu: 

1. Open the template file and switch to Split view. 
2. In the Code view, drag to select the closing </head> tag and <body class="column2"> 

tag near line 19 (see Figure 26). 

 
Figure 26 – Template Code to Select 

3. Replace the selected code with the following (see Figure 27): 

<link href="http://www.calstatela.edu/flyoutMenu.css" rel="stylesheet" 
type="text/css" /> 
<script type="text/javascript" src="http://www.calstatela.edu/flyoutMenu.js" 
language="JavaScript"></script> 
</head> 
<body class="column2" onload="menu_init(0,12,1,-20,10)"> 
NOTE: The above code can be copied and pasted from the code for template.txt data file. 

 
Figure 27 – Template After Adding the Fly-out Scripts 

NOTE: If using the three column template, change column2 to column3 in the body tag’s class 
attribute. 

4. Click the File menu and select Save to save the file. 
5. In the Files panel, double-click the verticalMenu.inc file located in the menus folder. 

The file opens in the Document window. 
6. Select the entire contents of the verticalMenu.inc file. 
7. Replace the selected code with the code in the flyoutVerticalMenu.txt data file (see 

Figure 28). 
8. Click the File menu and select Save to save the verticalMenu.inc file. 
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Figure 28 – Fly-out Version of verticalMenu.inc 

Editing the Fly-out Vertical Menu 
Editing a fly-out menu is a little more complicated than a static menu. Pay careful attention to the 
arrangement of the list elements in the verticalMenu.inc file. 
 
When editing the fly-out menu, note the following: 

• A submenu is a list within a list. The HTML <ul> and <li> tags are required, as well as 
their closing </li> and </ul> tags.  

• Links with submenus must have the class="menua" attribute applied to them. For 
example, in the code that was pasted in the verticalMenu.inc file, Links 1, 2, and 4 have 
submenus while Links 3 and 5 do not (see Figure 28). 

• For links with a submenu, or parent links, the code href="#maincontent" should not be 
changed. 

• Edit where a link points to using the same method as the other menus. Remember the 
following format: 

<a href="http://www.websiteURL.com">Link text (the words appearing on the 
webpage)</a> 

Horizontal Menu 
The horizontal menu only appears on the alternate version of the web templates (template file 
names ending in _a.php). The horizontal menu does not have an animated version; it is static. 
 
NOTE: Page authors who are not using the alternative style templates in their sites should skip to the 
Editing the Footer section of the handout. 
 
To edit the horizontal menu: 

1. In the Files panel, double-click the horizontalMenu.inc file located in the menus folder. 
2. In the Document window, replace the # symbol with the desired web address (URL). 
3. Replace the word Option with the link text you want to display in the horizontal menu 

(see Figure 29). 



Creating an Accessible Website Using Dreamweaver CS5.5 and the CSULA Web Templates 21 

4. Click the File menu and select Save to save the changes. 

 
Figure 29 – Horizontal Menu Include File 

Editing the Footer 
The footer requires few revisions. Users must update the mailto link. To revise any of the 
existing links, edit the URL in the href attribute or the link text, the text that appears in between 
the <a> and </a> tags. 
 
To update the mailto link: 

1. In the Files panel, double-click the footer.inc file located in the menus folder. 
2. Locate the contact the page author link near line 8. 

<li><a href="#">contact the page author</a></li> 
3. Replace the # symbol with mailto:you@example.calstatela.edu (see Figure 30). 

NOTE: Replace you@example.calstatela.edu with an appropriate CSULA department or club e-
mail address. 

 
Figure 30 – Mailto Link in the Footer 

To add a new link to the footer: 
1. Create a new line and add the hyperlink. Remember to follow this format:  

<li><a href="http://www.WebSiteLinkHere.com">Link text</a></li> 
2. Add a new separator bar by typing <li>|</li>.  

NOTE: To enter the pipe (the vertical bar), press the Shift+\ key combination. Users can also 
copy and paste from an existing separator. Do not put a separator before the first link or after the 
last link. 

3. Click the File menu and select Save to save the changes. 

Adding Metadata 
Adding metadata is the last modification needed before adding content to a template. Metadata is 
information imbedded in a web page that search providers such as Google and Bing can see. 
Metadata includes keywords and descriptions of the web page to make search engine results 
more accurate. Web page visitors cannot see the metadata unless they view the page’s source 
code. 
 



Creating an Accessible Website Using Dreamweaver CS5.5 and the CSULA Web Templates 22 

To add metadata: 
1. Open the template file and switch to Code view. 
2. Locate the opening <head> tag near the top of the page (see Figure 31). 
3. Under the <meta> tag and before the <title> tag, add the following code (see Figure 32): 

<meta name="author" content="Your Name" /> 
<meta name="keywords" content="Your Keywords" /> 
<meta name="description" content="Page Description" /> 

4. Update the metadata content. Replace Your Name with the appropriate department or 
club name. Remember to keep the quotation marks. Replace Your Keywords with 
keywords related to the page content, separated with commas. Replace Page Description 
with a short description of the web page. 

5. Enter a title between the <title> and </title> tags. 
6. Click the File menu and select Save to save the changes. 

 
NOTE: Dreamweaver’s auto-complete feature helps page authors avoid coding mistakes by displaying a 
list of frequently used tags as authors enter code in Code view. When the word to be entered is 
highlighted in blue below the mouse pointer, press the Enter key. Dreamweaver completes the tag, 
including any necessary equal signs and quotation marks. 

 
Figure 31 – Code Before Adding Metadata 

 
Figure 32 – Code After Adding Metadata 

Page authors now have a customized master template that they can use to create their entire site. 
To create a new web page, simply open the master template file and save it with a different file 
name. 

Creating Pages from the Master Template 
With completed personalized templates, users can add content to the main content division. A 
division is a block of content on an HTML page. When editing in Dreamweaver’s Design view, 
divisions are signified by dashed outlines. The outlines do not appear on the final page. Review 
the various templates and note the various page divisions. Note that the Cal State L.A. logo in the 
upper-left corner has its own division, the navigation menu has its own division, etc. 
 
To create a new page for a website using the master template, users simply need to open the 
master template and save it as a new page with a new name and title. 
 
To create the site’s main entry (index) page: 

1. Open the master template file. 
2. Click the File menu and select Save As. The Save As dialog box opens. 
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3. Navigate to the root folder, rename the file to index.php, and then click the Save button. 
4. In the Document toolbar, replace the text in the Title box with Welcome to CalStateLA 

Futurists Club (see Figure 33 and Figure 34). 
5. Click the File menu and select Save to save the changes. 

 

 
Figure 33 – Title Before 

 
Figure 34 – Title After

6. If the master template file is still open, close it to avoid making unwanted changes. 
 
NOTE: By convention, a website’s main entry page is named index. Any subsequent web pages should 
have short names describing the page content. 

Adding Main Content 
Dreamweaver makes adding new content to the main section of a web page very simple. In many 
cases, users can simply click and begin typing just as they would use a word processor. 
Advanced formatting may require that some extra steps be taken. A reference to all the styles 
provided by CSULA is available at the style samples page located at 
http://www.calstatela.edu/univ/templates/stylesamples.php. 
 
Remember that all content must reside in the main content division (see Figure 35). To check 
which division the mouse pointer is currently located in, review the tag hierarchy on the Status 
bar at the bottom of the Document window (see Figure 36). The main content division is listed as 
<div.column2#mainContent>. Notice that column2 corresponds to the template being used. 

 
Figure 35 – Highlighted Main Content Division 

 
Figure 36 – Tag Hierarchy on the Status Bar 

To add a new heading: 
1. First, decide where to place the new heading. 

• To place the new heading after an existing paragraph, position the insertion point at 
the end of the paragraph and press the Enter key. 

http://www.calstatela.edu/univ/templates/stylesamples.php
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• To place the new heading before a paragraph, position the insertion point at the 
beginning of the paragraph and press the Enter key. Then, press the Up Arrow key 
to position the insertion point in the newly created paragraph. 

2. Type This is my Heading. 
3. With the insertion point placed within the newly created heading, click the Text tab on 

the Insert toolbar (see Figure 37). 
4. Click the button for the appropriate heading style (h2, h3, etc.). Remember that h1 is 

reserved for page titles and should not be used as a heading. 
NOTE: To see examples of various heading styles, refer to the style samples page located at 
http://www.calstatela.edu/univ/templates/stylesamples.php. 

 
Figure 37 – Text Tab of the Insert Toolbar  

NOTE: Remember not to use the Bold , Italic , or h1  styles. 
 
To add a new paragraph after a heading: 

1. Position the insertion point at the end of the heading, press the Enter key, and type the 
paragraph text. 

2. To move to a new line within a paragraph without adding a new paragraph, press 
Shift+Enter. 
NOTE: A new paragraph will include some space to separate it from the heading and paragraphs 
before and after it. 

 
To bold text: 

1. Select the text to be emphasized. 
2. On the Text tab of the Insert toolbar, click the Strong button  (see Figure 37). 

 
To italicize text: 

1. Select the text to be emphasized. 
2. On the Text tab of the Insert toolbar, click the Emphasis button  (see Figure 37). 

 
To underline text: 

1. Select the text to be emphasized. 
2. Right-click the selected text, point to CSS Styles, and select the u class (see Figure 38). 

NOTE: If the u class is not visible on the shortcut menu, click the down arrow  to scroll down 
the list of CSS classes (see Figure 39). 

http://www.calstatela.edu/univ/templates/stylesamples.php
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Figure 38 – Setting a CSS Style from the Shortcut Menu 

 
Figure 39 – Scroll Down Arrow 

The style sheets associated with the CSULA web templates offer three different color choices for 
further emphasizing text: red, blue, and green. Users can style text using different combinations 
of the three color choices and the underline, strong, or emphasis options. 
 
To change the color of regular text: 

1. Select the text. 
2. Right-click the selected text, point to CSS Styles, and select blue, red, or green (see 

Figure 38). 
 
To underline or change the color of bold or italicized text: 

1. Select the bolded or italicized text. 
2. Right-click the <strong> or <em> tag in the hierarchy list on the Status bar, point to Set 

Class, and select one of the color choices (blue, red, or green) or u for an underline (see 
Figure 40). 
NOTE: There is no style allowing text to be both colored and underlined. Users must choose one 
or the other. 
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Figure 40 – Set CSS Class from the Status Bar 

To add a note: 
1. Create a new paragraph. 
2. Type Note: This is a note for noting things. 
3. Select the Note text, excluding the colon (:). 
4. On the Text tab of the Insert toolbar, click the Strong button . 
5. Right-click the selected Note text, point to CSS Styles, and select note. Notice that the 

Note text slightly indents (see Figure 41 and Figure 42).  

 
Figure 41 – Note as Seen in Dreamweaver’s Design View 

 
Figure 42 – Note as Seen in a Browser 

To add a hyperlink: 
1. Enter or select the text to be used for the link. 
2. On the Common tab of the Insert toolbar, click the Hyperlink button . The 

Hyperlink dialog box opens. 
NOTE: There are two types of links, internal (links to web pages that are part of the same 
website) and external (links to web pages that are not part of the same website). 

3. To link to an internal web page, click the Browse button  next to the Link box, select 
the PHP page to link to, and then click the OK button. 

4. To link to an external web page, in the Link box, enter the web address (URL) of the web 
page to link to. The web address must start with http://. For example, to link to the Cal 
State L.A. home page, enter http://www.calstatela.edu. 

5. To have the link open in a new browser window, click the Target arrow and select 
_blank from the list.  

6. Enter a link description in the Title box.  
7. Click the OK button. 
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To add a Back to Top hyperlink: 
1. Position the insertion point on a new line at the bottom of the web page. 
2. Type TOP. 
3. Select the TOP text.  
4. On the Common tab of the Insert toolbar, click the Hyperlink button . The 

Hyperlink dialog box opens. 
5. In the Link box, type #mainContent. 
6. In the Title box, type Top of Page. 
7. Click the OK button. 
8. Right-click the selected TOP text and select Edit Tag <a>. The Tag Editor dialog box 

opens. 
9. Select Style Sheet/Accessibility in the left pane. 
10. In the Class box, type top. 
11. Click the OK button. 

Viewing Your Work 
Page authors can usually preview their HTML pages with Dreamweaver’s Preview in Browser 
feature. However, because a web server dynamically creates HTML pages using PHP, some files 
created in this handout cannot be viewed with a web browser. The easiest way to preview the 
PHP files is with Dreamweaver’s Live view option. Live view translates the PHP code into 
simple HTML and displays the page in the Document window as it would appear in a web 
browser. 
 
To use Live view: 

1. Click the Design button on the Document toolbar. 
2. Click the Live View button on the Document toolbar. 
3. Browse the page inside Dreamweaver. Hold down the Ctrl key and click a link to follow 

it. 
 
Although testing servers can be used to preview PHP files, they are outside the scope of this 
handout. For more information on testing servers, refer to the Extras section of the Download 
Web Template page located at http://www.calstatela.edu/univ/templates/downloads.php. 

Accessibility and Section 508 Requirements 
Making web pages accessible to users with disabilities is good web programming practice. In the 
case of websites such as http://www.calstatela.edu, it is required by law. 
 
Section 508 of the Rehabilitation Act of 1973 is a U.S. law requiring electronic technology used 
by government agencies to be accessible. The CSU system mandates that all CSU campuses 
must adhere to these standards. In this section of the handout, page authors will review the 
different accessibility requirements and learn how to repair pages that do not meet accessibility 
guidelines. 
 
For more information on Section 508 requirements and solutions, visit the CSULA web 
accessibility website at http://www.calstatela.edu/accessibility/508.php. Page authors may also 
reference other accessibility workshop handouts such as Web Accessibility Awareness and Web 
Author Workshops A and B located at http://www.calstatela.edu/handouts in the ‘W’ section. 
 

http://www.calstatela.edu/univ/templates/downloads.php
http://www.calstatela.edu/
http://www.calstatela.edu/accessibility/508.php
http://www.calstatela.edu/handouts
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NOTE: The capital letters within parentheses refer to the particular Section 508 standard. 

Screen Readers and Accessibility 
The Internet is a vast landscape of information, most of which is represented visually. For those 
with visual impairments, navigating a computer and the web can be difficult. Screen readers are 
programs that read aloud the on-screen information. They can “read” any words found on the 
screen including window titles, button names, or any other plain text source. However, screen 
readers cannot “read” pictures, charts, graphs, and other visual representations of information. 
Adding alternate text descriptions for pictures and tables and using hidden descriptions to label 
sections of the site are two easy ways to help screen readers “read” a web page. 

Alt and Longdesc Attributes (A) 
The first Section 508 standard is one of the easiest to follow. All images on an HTML page must 
include an alternate text, also known as alt text. When a screen reader finds an image on a web 
page, it announces the text in the alt attribute of the image HTML tag. The alt text should include 
a short description of the image. If the image is purely decorative and contains no important 
information, enter empty quotations (e.g., alt="") for the alt text. Images conveying important 
information should include appropriate alt text that explains the image’s content. 
 
To set the banner image’s alt text: 

1. Click the banner image. 
2. In the Properties panel, click the Alt arrow and select <empty>. 

 
Users can leave alt text empty, provided they select empty as outlined above. Not selecting 
empty removes the alt attribute resulting in a less accessible site. Screen readers skip any image 
with an <empty> alt attribute. If alt text is not empty, screen readers will read the file name or 
some other information about the image. The banner image is a perfect example of when to use 
empty alt text because it is only used for decoration. 
 
Find more information about alt text at http://www.calstatela.edu/accessibility/p_img.php. 

Colors and Contrast (C) 
Section 508 standard C requires a contrast ratio of 5:1 between background and foreground 
colors. Testing a web page’s color contrast requires the use of a program such as the Color 
Contrast Analyzer. 

• For a step-by-step guide to downloading and using the Color Contrast Analyzer, 
download the Web Author Workshop A handout at 
http://www.calstatela.edu/its/docs/pdf/atiworkshopa.pdf. 

• For a video tutorial on using the Color Contrast Analyzer, please visit 
http://www.youtube.com/user/MyCSULA#grid/user/15E04DED3747036F (see part 
7.3a). 

 
Although the color schemes used in the template pages should meet the color contrast 
requirements, page authors should still carefully choose the color combinations used on their 
pages. 
 
Find more information about this mandate at http://www.calstatela.edu/accessibility/p_col.php.  

http://www.calstatela.edu/accessibility/p_img.php
http://www.calstatela.edu/its/docs/pdf/atiworkshopa.pdf
http://www.youtube.com/user/MyCSULA#grid/user/15E04DED3747036F
http://www.calstatela.edu/accessibility/p_col.php
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Readability, With or Without Style Sheets (D) 
Section 508 standard D states that documents shall be organized so they are readable without 
requiring an associated style sheet. Typically, CSS styles are used to define the look and feel of a 
web page. If site visitors disable styles or use their own style sheets, the web page should remain 
fully usable with headings, paragraphs, hyperlinks, and lists being sensible and obvious to the 
viewer. 
 
Page authors using the CSULA CSS style sheets should find no conflicts. However, authors who 
create their own styles must ensure those styles do not conflict with any styles the user applies 
locally. 
 
To preview a site with styles disabled, use the Web Developer extension for Mozilla Firefox 
(http://www.mozilla.com). The Web Author Workshop A handout, available at 
http://www.calstatela.edu/handouts, explains how to download the Web Developer extension for 
Firefox. 
 
For more information on style sheets and readability, please visit 
http://www.calstatela.edu/accessibility/p_rea.php. 

Image Maps (E & F) 
Image maps allow sections of an image to link to different websites. These embedded links can 
be very useful for large images, such as a map of a campus. Although image map creation is not 
covered in this handout, page authors should know the restrictions placed on using them. 
 
For more information on creating image maps, please refer to the Dreamweaver CS4 part 3 
handout located at http://www.calstatela.edu/handouts in the ‘A’ section. Dreamweaver can 
create client-side accessible image maps. To meet Section 508 standards E and F, add alternate 
text for each area on the image map. For more information on the Section 508 requirements for 
image maps, refer to http://www.calstatela.edu/accessibility/p_map.php. 

Tables (G & H) 
Tables are a great way to visually organize information on a web page. However, tables can 
easily confuse screen readers or other assistive technology. The proper use of table heading <th> 
and table data <td> cell tags is a must. To properly associate a header cell with the cells it 
describes, use the scope attribute. 
 
To create a table in Dreamweaver: 

1. Place the mouse pointer in the main content division where you want to insert the table. 

2. Click the Table button  on the Insert toolbar. The Table dialog box opens (see 
Figure 43). 

3. In the Rows and Columns boxes, enter the number of rows and columns for the table. 
4. Change the value in the Table width box to 100 percent. 
5. In the Header section, select the option that matches the table layout you want to create. 

(Left adds row headers, Top adds column headers, etc.) 
6. In the Summary box, add a short summary of the table contents. 

NOTE: Text entered in the Caption box appears on the page. Text entered in the Summary box 
will only be read by screen readers. 

http://www.mozilla.com/
http://www.calstatela.edu/handouts
http://www.calstatela.edu/accessibility/p_rea.php
http://www.calstatela.edu/handouts
http://www.calstatela.edu/accessibility/p_map.php
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7. Click the OK button to create the table. Dreamweaver automatically adds the scope 
attributes based on the selected Header option. 

 
Figure 43 – Table Dialog Box 

Page authors wanting to change the layout of the header cells will have to manually edit the code 
and change the scope attributes accordingly or create a new table with Dreamweaver’s Table 
button and then transfer the content. 
 
For more information on the scope attribute and how to manually add it to tables, visit 
http://www.calstatela.edu/accessibility/p_tab.php. 

Screen Flickering (J) 
Section 508 standard J states that pages shall avoid causing the screen to flicker with a frequency 
greater than 2Hz or lower than 55Hz. Although this mandate applies to web pages, it may be 
more applicable to animations and other plug-ins. Avoid using the <blink> or <marquee> tags to 
comply with this standard. 
 
Find more information about screen flickering at 
http://www.calstatela.edu/accessibility/p_fli.php. 

Plug-ins (M) 
Section 508 standard M states that pages containing a link to a file requiring an applet, plug-in, 
or other application be present on the client system (site visitor’s computer) to interpret the page 
content, must provide a link to the application that can open the file. 
 
Examples of file types requiring plug-ins include Adobe Acrobat and Flash files, Microsoft 
Word, PowerPoint, and Excel files, and music and video files. Refer to 
http://www.calstatela.edu/accessibility/p_plu.php for examples of code that can be copied and 
pasted into web pages to fulfill this requirement. 

http://www.calstatela.edu/accessibility/p_tab.php
http://www.calstatela.edu/accessibility/p_fli.php
http://www.calstatela.edu/accessibility/p_plu.php
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Forms (N) 
Forms are a very common method of obtaining user information. Forms can be used to log into a 
service, create a new account, or simply gain user feedback. It is very important that forms be 
accessible because their complex layouts often confuse screen readers. 
 
To make a form more accessible, use the fieldset tag to group similar form entries. Fieldsets are 
very useful for check box and radio groups, but they can be used to group any number of form 
elements. Use the Fieldset button  to create a new fieldset. After creating and naming a 
fieldset, add form elements by simply selecting them from the Insert toolbar (see Figure 44). 

 
Figure 44 – Forms Tab of the Insert Toolbar 

In addition to fieldsets, labels can be used to make form elements easily identifiable to a screen 
reader. When creating a new form element such as a text field, text area, list, or menu from the 
Insert toolbar, use the Input Tag Accessibility Attributes dialog box (see Figure 45). Enter a 
unique name for the form entry in the ID box. Be aware that duplicate IDs are not allowed. In the 
Label box, enter the label that should appear on the website. Select the appropriate option to 
position the label before or after the form field. Leave the Attach label tag using ‘for’ attribute 
option selected since it is the most accessible-friendly option. Page authors can also set a Tab 
Index which sets the navigation order of form elements beginning from the number one. Click 
the OK button to close the dialog box. 

 
Figure 45 – Input Tag Accessibility Attributes Dialog Box 

The Checkbox Group dialog box offers users different options for check box or radio groups (see 
Figure 46). Enter a name for the entire group of options in the Name box. To add a new check 
box item, click the plus button. The check box label appears on the web page while the value is 
passed to the server if that option is selected. Click the OK button and Dreamweaver will create 
an accessible check box group. 
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Figure 46 – Checkbox Group Dialog Box 

For more information on creating accessible forms, visit 
http://www.calstatela.edu/accessibility/p_for.php. 

Time Delays (P) 
Section 508 standard P states that when a timed response is required, the user shall be alerted and 
given sufficient time to indicate more time is required. Users with certain disabilities may require 
more time to read a page or complete a form, and web pages should allow for this requirement. 
For more information on the use of time delays, please visit 
http://www.calstatela.edu/accessibility/p_tim.php. 

Topics Not Covered 
Please note that the accessibility portion of this handout covers only a fraction of the 
requirements set by the Section 508 guidelines. For the full list and more information, please 
visit http://www.calstatela.edu/accessibility/508.php. Below is a list of the topics not covered in 
this handout: 

• Captions (B) – any video or multimedia presentation with a voice-over must be 
captioned. 

• Frames (I) – if frames must be used, they must be properly titled and named. 
• Text-Only Alternative (K) – a text-only alternative must be provided for any element 

not following the other accessibility guidelines. 
• Scripts (L) – any script used to generate content must be accessible. Also, pages must 

function properly even if the user turns scripts off. 
• Skipper (O) – a method to skip repetitive links must be provided. The CSULA web 

templates include a skipper. 

Dreamweaver CS5.5 Site Reports 
Dreamweaver’s site reports allow users to check for several types of errors including broken 
links, missing alt text, and untitled web pages. After finding and fixing problem areas, page 
authors should run site reports again to ensure that all problems have been resolved. 
 
NOTE: A site must be defined or imported before running a site report. Individual pages do not need to be 
opened before running a site report. 
 

http://www.calstatela.edu/accessibility/p_for.php
http://www.calstatela.edu/accessibility/p_tim.php
http://www.calstatela.edu/accessibility/508.php
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To run a site report: 
1. Click the Window menu, point to Results, and select Site Reports. The Site Reports tab 

of the Results panel displays (see Figure 47). 

 
Figure 47 – Site Reports Tab of the Results Panel 

2. Click the Reports button  located in the upper-left corner of the Results panel. The 
Reports dialog box opens (see Figure 48). 

3. Click the Report on arrow and select Entire Current Local Site from the list. 
4. Under HTML Reports, select the Missing Alt Text and Untitled Documents check 

boxes. 

 
Figure 48 – Reports Dialog Box 

5. Click the Run button. The errors are listed in the Results panel (see Figure 49). 

 
Figure 49 – Errors Report 
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To fix the errors: 
1. In the Results panel, under the File column, double-click the file with the missing page 

title or alt attribute. The document opens in Split view and the code with errors is 
highlighted. 

2. To fix the missing title, enter a page title in the Title box of the Document toolbar (see 
Figure 34). 

3. To fix a missing alt attribute, enter an image description in the Alt box of the Properties 
panel (see Figure 50). 

 
Figure 50 – Alt Attribute Box 

Checking Links 
Broken links can occur throughout the duration of the website development process. They are 
often the result of forgetting to update links, renaming files outside of the Dreamweaver 
program, or linking to non-existent sites. 
 
To check for broken links: 

1. Click the Window menu, point to Results, and select Link Checker. The Link Checker 
tab of the Results panel displays. 

2. Click the Check Links button  located in the upper-left corner of the Results panel 
and select Check Links For Entire Current Local Site. The errors are listed in the 
Results panel (see Figure 51). 

 
Figure 51 – Broken Links Report 

3. In the Results panel, under the Files column, double-click a file with broken links to 
open the page. The code with errors is highlighted. 

4. In the Properties panel, click the HTML button. 
5. Change the link location in the Link box (see Figure 52). 

 
Figure 52 – HTML Properties 
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NOTE: Because of the way PHP creates the menus, the Link Checker may report working links as 
broken. Any link to #maincontent located in one of the menu include files (verticalMenu.inc, 
horizontalMenu.inc) will work correctly after the PHP interpreter creates the page and serves it to the 
user. 

CSULA Accessibility Resources 
Although there are many accessibility issues, page authors have many accessibility resources for 
getting help. Start with the CSULA Web Accessibility Guidelines website located at 
http://www.calstatela.edu/accessibility. Here, page authors can find information about the 
Section 508 guidelines, testing tools, and other resources. 
 
For tutorials on web accessibility, visit http://www.calstatela.edu/accessibility/tutorials.php. 
 
Before publishing pages, authors should visit http://www.calstatela.edu/accessibility/tools.php to 
find free programs and web resources for testing the accessibility of their website. To help 
identify potential problems that automated programs are not able to catch, visit the Manual 
Evaluation Checklist page located at http://www.calstatela.edu/accessibility/manual.php. 

Getting Help 

Other ITS Training Program Workshops 
• Web Accessibility Awareness 

Handout: http://www.calstatela.edu/its/docs/pdf/adaawareness.pdf 
• Web Author Workshop A: Accessibility Tools and Reports 

Handout: http://www.calstatela.edu/its/docs/pdf/atiworkshopa.pdf 
• Web Author Workshop B: Manual Accessibility Checks 

Handout: http://www.calstatela.edu/its/docs/pdf/atiworkshopb.pdf 

Accessibility Help 
Making web pages accessible is a top priority for web developers. Therefore, there are several 
resources for learning how to make a web page accessible to those with disabilities. Below are 
some helpful links regarding web accessibility. 

Web Accessibility Laws and Standards 
• Section 508: The official Section 508 information website: http://www.section508.gov. 
• World Wide Web Consortium (W3C): An international consortium where members, 

full-time staff, and the public work together to develop web standards. Their mission is to 
lead the World Wide Web to its full potential by developing protocols and guidelines that 
ensure long-term growth for the web. W3C establishes its own set of Web Content 
Accessibility Guidelines (WCAG) containing additional measures for making pages more 
universally accessible. Web authors and developers are encouraged to also comply with 
the W3C guidelines. 

o W3C: http://www.w3.org 
o WCAG: http://www.w3.org/TR/WAI-WEBCONTENT 
o Web Accessibility Initiative (WAI): http://www.w3.org/WAI/ 

http://www.calstatela.edu/accessibility
http://www.calstatela.edu/accessibility/tutorials.php
http://www.calstatela.edu/accessibility/tools.php
http://www.calstatela.edu/accessibility/manual.php
http://www.calstatela.edu/its/docs/pdf/adaawareness.pdf
http://www.calstatela.edu/its/docs/pdf/atiworkshopa.pdf
http://www.calstatela.edu/its/docs/pdf/atiworkshopb.pdf
http://www.section508.gov/
http://www.w3.org/
http://www.w3.org/TR/WAI-WEBCONTENT
http://www.w3.org/WAI/
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Web Accessibility Awareness 
• CSU ATI: A website providing online tutorials for creating accessible content, a list of 

sister campus ATI websites, and ATI newsletters: http://www.calstate.edu/accessibility. 
• CSULA ATI: A website providing information on the progress of ATI at CSULA, 

outlining the responsibilities of the three working groups: 
http://www.calstatela.edu/accessibility/ati. 

• Web Accessibility 101: Web-based training materials offering short video tutorials with 
practice data files. Topics include web accessibility concept, accessibility testing, and 
how to apply accessibility principles to new and existing sites using standards compliant 
markup and Cascading Style Sheets (CSS). This training can only be accessed on a 
campus networked computer. To view these videos from off campus, you need to 
establish a VPN connection to the Cal State L.A. network: 
http://www.calstatela.edu/accessibility/video/principles.php. 

• WebAim Introduction to Web Accessibility: A website that provides extensive 
information on creating accessible content for web delivery, print, and video/audio: 
http://webaim.org/intro/. 

Testing Web Pages and Web Tools 
• CSULA Accessibility Tools: A list of various tools and sites recommended by CSULA 

for verifying the accessibility of websites: 
http://www.calstatela.edu/accessibility/tools.php. 

• CSULA Web Accessibility Tutorials: A list of various tutorials on the web for 
developing accessible web pages: http://www.calstatela.edu/accessibility/tutorials.php. 

• Manual testing tools 
o CSULA cheat sheet: A simple online form that is designed to complement 

automated evaluation tools for website accessibility with an emphasis on areas 
that can only be evaluated realistically by human judgment. This checklist is 
based on Tom Jewett’s Manual Accessibility Evaluation and is edited to follow 
CSULA requirements: 
http://www.calstatela.edu/accessibility/manual.php 

o Manual Accessibility Evaluation by Tom Jewett: 
http://www.tomjewett.com/accessibility/evaluation.html 

o Testing for Accessibility by Jim Thatcher: 
http://www.jimthatcher.com/testing.htm 

• Accessibility toolbars 
o AIS Toolbar: Free accessibility toolbar for Internet Explorer: 

http://www.visionaustralia.org.au/info.aspx?page=614%20 
o Firefox Web Developer Toolbar: Free accessibility toolbar for Mozilla Firefox: 

http://addons.mozilla.org/en-US/firefox/addon/web-developer/ 
• Screen readers: Free Screen readers for download: 

o Non-Visual Desktop Access for Windows: http://www.nvda-project.org/ 
o FireVox for Mozilla Firefox: http://www.firevox.clcworld.net/ 

• A Complete List of Web Accessibility Evaluation Tools maintained by W3C: 
http://www.w3.org/WAI/RC/tools/complete 

CSULA Support 
Below is a list of the CSULA support groups that can provide assistance with web accessibility 
issues: 

http://www.calstate.edu/accessibility
http://www.calstatela.edu/accessibility/ati
http://www.calstatela.edu/accessibility/video/principles.php
http://webaim.org/intro/
http://www.calstatela.edu/accessibility/tools.php
http://www.calstatela.edu/accessibility/tutorials.php
http://www.calstatela.edu/accessibility/manual.php
http://www.tomjewett.com/accessibility/evaluation.html
http://www.jimthatcher.com/testing.htm
http://www.visionaustralia.org.au/info.aspx?page=614%20
http://addons.mozilla.org/en-US/firefox/addon/web-developer/
http://www.nvda-project.org/
http://www.firevox.clcworld.net/
http://www.w3.org/WAI/RC/tools/complete
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• Information Technology Services (ITS) Help Desk: http://www.calstatela.edu/helpdesk 
Location: Library Palmer Wing Lobby 
Telephone: 323-343-6170 
E-mail: helpdesk@calstatela.edu 

• Center for Effective Teaching and Learning (CETL): http://www.calstatela.edu/cetl 
• Information Technology Consultants (ITCs): http://www.calstatela.edu/itc 

HTML Help 
Some page authors may find it beneficial to learn more about the code used to create web pages. 
There are plenty of tutorials on the web regarding HTML. A good place to start is with the 
organization that standardized the HTML language, the World Wide Web Consortium (W3C). 
 
W3C’s online web development tutorial site is http://www.w3schools.com/. 
 
Step-by-step guides for creating web pages with HTML are available at 
http://www.calstatela.edu/handouts. 

Dreamweaver CS5.5 Help 
Complete product help is available on the Dreamweaver Help and Support website 
(http://www.adobe.com/support/dreamweaver/) which can be accessed using the Help menu. 
Some of the online Help content is also available offline, should users be unable to connect to the 
Internet. 
 
To access Dreamweaver CS5.5 help: 

1. Click the Help menu and select Dreamweaver Help (see Figure 53). Or, type a search 
term in the search box located on the right side of the Application bar and press the 
Enter key (see Figure 54). The Adobe Community Help window opens displaying the 
Adobe Dreamweaver CS5 & CS5.5 help topics. 

 
Figure 53 – Dreamweaver CS5.5 Help Menu 

 
Figure 54 – Dreamweaver CS5.5 Search Box 

http://www.calstatela.edu/helpdesk
mailto:helpdesk@calstatela.edu
http://www.calstatela.edu/cetl
http://www.calstatela.edu/itc
http://www.w3schools.com/
http://www.calstatela.edu/handouts
http://www.adobe.com/support/dreamweaver/
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Useful Dreamweaver Shortcuts 
Dreamweaver CS5.5 utilizes many useful shortcut keys. The table below contains the most 
commonly used shortcuts (see Table 5). 
 
Table 5 – Shortcuts in Dreamweaver CS5.5 

Shortcut Description 
Ctrl+N New document 
Ctrl+S Save document 
Ctrl+Alt+I Insert image 
Ctrl+F Find and replace 
Ctrl+J Page properties 
Shift+F7 Check spelling 
Shift+Enter Line break 
F8 Files panel 
Ctrl+F2 Insert panel 
Ctrl+F3 Properties panel 
Shift+F10 History panel 
F10 Code Inspector panel 
Shift+F4 Behaviors panel 
F12 Preview in primary browser 
Ctrl+F12 Preview in secondary browser 
Double-click Select a word 
Triple-click Select a paragraph 
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